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1.1  Overview

This document is designed to help users understand Wind River Probe, the Wind 
River on-chip debugging tool. The Wind River On-Chip Debug Solution includes 
Wind River Probe and Wind River Workbench, a software tool for hardware and 
RTOS bring-up. Together, these products provide a fully integrated hardware and 
software solution that can be used to bring up a target board, to program flash, and 
for production and testing.

Use Wind River Probe to perform source-level debug activities, such as watching 
memory and controlling large numbers of registers. Wind River Probe can shorten 
development cycles, even for extremely complex applications.

This document outlines information that is specific to Wind River Probe. Some 
information in this manual explains how to perform functions with Wind River 
Probe and Wind River Workbench; for detailed information about using the 
debugger, please see the Wind River Workbench User’s Guide and the Wind River 
Workbench for On-Chip Debugging User Tutorials. 
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This document includes the following chapters:

■ 1. Introduction — Provides a high level overview of the Wind River Probe 
product.

■ 2. Setting Up Hardware — Describes how to make all of the physical 
connections between Wind River Probe, the target, and your host computer.

■ 3. Installing Drivers -- Describes procedures for installing the Wind River Probe 
drivers on Windows and Linux hosts.

■ 4. Establishing Communications— Describes using Wind River Workbench to 
connect to Wind River Probe and your target.

■ 5. Troubleshooting -- Describes troubleshooting procedures for various 
problems.

1.2  System Overview

Wind River Probe lets you control a target by utilizing the On-Chip Debugging 
(OCD) services embedded in the microprocessor of that target. A high-speed USB 
connection from your PC enables you to communicate with the OCD services that 
are resident in the microcode of the chip. 

When you access the OCD services in the chip, you have complete control of the 
microprocessor, and all interaction between Wind River Probe and the target runs 
exclusively through the OCD connection. This means that your system is effective 
for the entire development process, even before board-level peripherals are stable.
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1.3  Features

Wind River Probe includes the following features:

■ High Speed USB Download

Wind River Probe provides a High Speed USB 2.0 connection to your host PC 
that enables you to download code to your target extremely quickly. 

■ On-Chip Debug Target Control

Wind River Probe lets you start and stop a target, set internal hardware and 
software breakpoints, take a target snapshot, reset a target, step one statement 
or instruction, step into function calls, and step over or out of a function.

■ Built in Hardware Diagnostics

Wind River Probe includes a comprehensive suite of RAM tests, scope loops, 
and CRC tests. 

Figure 1-1 Wind River Probe
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■ Additional Custom Registers

Wind River Probe supports 32 custom register groups, which results in a total 
of 960 custom registers. 

■ Target Versatility

Wind River Probe allows the user to test several target architectures using the 
same debug hardware. 

1.4  Safety Information

There are some basic safety precautions that you should observe when using 
Wind River Probe. Follow these precautions to help avoid injury and prevent 
damage to Wind River Probe and any products connected to it. To avoid hazardous 
conditions, use this product only as specified. For the purposes of this document, 
warning and caution symbols denote the following:

Precautions to avoid injury

! WARNING:  Warning statements indicate conditions that could result in injury or 
loss of life, and describe how to avoid them.

! CAUTION:  Caution statements indicate conditions that could result in damage to 
this product or other property and describe how to avoid them. 

! WARNING:  Do not operate in wet or damp environments or outside the 
recommended operating conditions. This product is intended for indoor use only.

Do not operate this product in an explosive atmosphere.

Do not operate the product if it is damaged. Have a qualified service person 
inspect damaged equipment before use.
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Precautions to avoid property damage

! CAUTION:  Take precautions against electrostatic discharge as it may damage some 
components.

Use care in handling, as delicate components can be easily damaged. 

Provide proper ventilation to prevent the product from overheating. 
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2.1  Introduction

This chapter describes all of the hardware that is included with Wind River Probe 
and explains how to connect it correctly to the target and host.

For Wind River Probe to function correctly, you must:

■ Install Wind River Workbench

■ Connect Wind River Probe to a host

NOTE:  To install the drivers for the Wind River Probe you must have 
administrator privileges on your computer.
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■ Connect Wind River Probe to a target

This chapter discusses these steps and provides some general information about 
the Wind River Probe hardware. 

2.2  Wind River Probe Components

The following list describes all of the components included with the Wind River 
Probe shipment. If any components are missing, please contact Wind River 
Customer Support. 

■ Wind River Probe unit

■ 1 High Speed USB cable

■ 1 target-specific adapter

2.3  Unpacking Information

Remove Wind River Probe from its box and place it on the desk or bench so that it 
is not covered. Remove any packing materials to ensure proper cooling. 
Wind River Probe operates without requiring additional cooling. 

NOTE:  Wind River Workbench must be installed on your host computer before 
you connect the Wind River Probe. If you connect the Wind River Probe before you 
install Workbench, Wind River Probe may not communicate properly with 
Workbench.

! CAUTION:  Handle Wind River Probe with caution and take measures to prevent 
electrostatic discharge.



2  Setting Up Hardware
2.4  Wind River Probe Description

9

2

2.4  Wind River Probe Description

This section describes all the features that are physically located on the Wind River 
Probe unit. The descriptions are high-level, and meant to be used strictly as a 
method of becoming familiar with the unit. To make use of these features, see 
4. Establishing Communications.

2.4.1  Top of Wind River Probe

Figure 2-1 shows a labeled diagram of the top of the Wind River Probe unit. Use 
this diagram to locate the components described in this section.

Wind River Probe LEDs

There are two LEDs located on the top of the Wind River Probe enclosure. Table 2-1 
describes the function of each LED.

Figure 2-1 Top view of Wind River Probe

LEDs

Coaxial cableConnector
Adapter

Table 2-1 Wind River Probe LED Descriptions

LED Description

Power/Activity When steady green, this indicates that power is applied to the 
Wind River Probe. This means that Wind River Probe is ready for 
normal operation. When flashing green, it indicates activity.

Run/Debug When steady green, this LED indicates that Wind River Probe is in 
Run mode. 

When steady yellow, this LED indicates that Wind River Probe is in 
Debug mode. When flashing yellow, it indicates that Wind River 
Probe is in Error mode and cannot communicate with the target 
correctly. Fix this problem before you continue.
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Probe Cable and Connector 

Wind River Probe is built with a permanent high-speed coaxial cable with a 
universal debug connector, which connects ground first and corrects for 
differences in ground voltage potentials. This allows Wind River Probe to be 
hot-plugged to a live target.

2.4.2  Target-specific adapter

Wind River Probe is shipped with a target-specific adapter (Figure 2-2) which 
connects to the OCD port on your target and is necessary for configuring 
Wind River Probe for specific target architectures. Connecting this adapter to the 
end of the Wind River Probe cable allows Wind River Probe to be used over several 
architectures. See 2.7 Connecting Wind River Probe to a Target, p.12.

Figure 2-2 Target-specific adapter (16-pin version shown)

Ground hole
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2.5  Layout Drawings

Figure 2-3 shows the dimensions of the Wind River Probe unit. All dimensions are 
in inches unless otherwise noted.

2.6  Connecting Wind River Probe to a Host

In order for Wind River Probe to function correctly, it must be properly connected 
to a host computer. The supplied USB cable connects Wind River Probe to a USB 
port on your host computer. 

The cable is a 6-foot High Speed USB 2.0-compliant cable with one USB type A 
connector and one five-wire mini-B connector.

Figure 2-3 Layout Drawings

NOTE:  Wind River Probe must be connected to a high-powered USB port. If 
connected to a low-powered USB port, for example a port on a bus-powered hub, 
Wind River Probe may not function correctly.
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To connect Wind River Probe to your host: 

1. Insert the A connector of the USB cable into the USB port on your host 
computer. Insert the five-wire mini-B connector of the USB cable into the port 
on the back of the Wind River Probe unit as shown in Figure 2-4.

2.7  Connecting Wind River Probe to a Target

First connect the target-specific adapter to your target board, then connect the 
Wind River Probe coaxial cable to the adapter. Connect to the target in this order. 
(See Figure 2-5 for proper connection procedure.)

To connect Wind River Probe to a target for hot-swapping capability, complete the 
following steps. 

1. Make sure Wind River Workbench is installed on your host computer.

2. Connect adapter to your target.

NOTE:  Use only the supplied USB cable to connect Wind River Probe to your host. 
Substituting a different cable may result in Wind River Probe failing to work 
correctly.

Figure 2-4 USB connector

Five-wire mini-B USB Port

! CAUTION:  Under no circumstances should the Wind River Probe unit be connected 
to a target if there is a ground difference capable of supplying high current.
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3. Connect the Wind River Probe cable to the adapter.

2.7.1  Grounding Wind River Probe and the Target

If Wind River Probe is used under conditions where the adapter must remain 
attached to the Wind River Probe cable, a grounding procedure may be needed. 
The target adapter is equipped with a ground hole for this purpose. To prevent 
damage to either the Wind River Probe unit or the target board, complete the 
following steps.

1. Attach a ground wire to the ground hole on the flange of the adapter (See 
Figure 2-2.)

2. Connect this ground wire to your target.

3. Connect the adapter to your target. Make sure that the ground pin on your 
target is the first point to make contact.

! CAUTION:  Make sure the pin labeled 1 on your adapter lines up with the pin 
labeled 1 on the OCD port on your target. Pin 1 on the adapter is on the corner of 
the adapter marked with a white triangle.
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Figure 2-5 Connection Procedure

Connect adapter to target first



15

   3
Installing Drivers

3.1 Introduction 15

3.2 Windows Hosts 15

3.3 Linux Hosts 16

3.1  Introduction

The installation DVD shipped with your Wind River Probe contains drivers for 
both Windows and Linux hosts.

3.2  Windows Hosts

On Windows systems, Administrator privileges are required to install the drivers 
for the Wind River Probe.

To install the drivers for the Wind River Probe, insert the Workbench installation 
DVD into your computer’s DVD drive and follow the steps in the installation 
wizard.
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Windows XP users may see a screen prompt that states that the drivers for 
Wind River Probe are not logo-certified by Microsoft. This will not affect the 
performance of the Wind River Probe. You should continue when prompted to do 
so.

3.3  Linux Hosts

The Wind River Probe USB driver must be rebuilt for the kernel you are using; 
therefore the kernel source is required. The name of the kernel source RPM is either 
kernel-source-.... or kernel-devel-...., depending on the version of Linux you are 
using. If you do not have your kernel source, you can obtain it from:

http://rpmfind.net/linux/RPM

Also, you must have the rpmbuild and gcc packages installed on your system.

To use the Wind River Probe, you must install both the WRProbeService and the 
Jungo USB driver. This RPM package handles the installation of both these 
products.

There are two commands required to complete the installation. The first command 
extracts all the source and rebuilds the driver module (windrvr6) for the kernel in 
use. It then packages these files into a binary RPM for installation. The second 
command unpacks the binaries and installs them on your system.

The binary RPM package that gets created is put in a directory dependent on the 
rpmbuild installation. The last few lines of output from the rpmbuild command 
display the location of the binary RPM file to use.

If the WRProbeDriver package already exists on your system, you should 
uninstall it before this installation. To see if the package exists on your system, run 
the following command:

rpm -q WRProbeDriver

To uninstall, login as root and run the following command:

rpm -e WRProbeDriver

To install the driver, login as root and run the following commands:

rpmbuild --rebuild WRProbeDriver-${SVC_VER}_${DRV_VER}-${REL}.src.rpm
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rpm -ivh ${RPM_OUTPUT_DIRECTORY_FROM_LAST_CMD}/WRProbeDriver-${SVC_VER}_ 
${DRV_VER}-${REL}.i386.rpm

where the macros are:

${RPM_OUTPUT_DIRECTORY_FROM_LAST_CMD} -- Directory where the new 
RPM file is located

${SVC_VER} -- WRProbeSvc version

${DRV_VER} -- Version of USB driver

${REL} -- RPM release number

NOTE:  Although this installation makes every attempt to use the appropriate 
source code to build the module, it will fail without a clear error code in one 
specific circumstance. If the file 
/lib/modules/`uname-r`/source/include/linux/version.h contains a version 
number that does not match the version of the running kernel, the build process 
may not work properly. Please be sure to check this if the installation fails.

To recover from this situation, uninstall all kernel source packages, reinstall the 
correct source package, then reinstall this package.
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4.1  Introduction

After you install the Wind River Workbench software and connect the Wind River 
Probe hardware, use Workbench to establish communications with your target. 

Workbench enables you to use both high and low-level commands to work with 
your target. After you establish communications with your target, you can use the 
Workbench Graphical User Interface (GUI) to work with your target. 

NOTE:  This chapter assumes that the Wind River Workbench software is installed 
and running on your host computer. 



Wind River Probe for Wind River Workbench
Hardware Reference , 2.6.1  

20

If you are more comfortable using low-level commands, you may do so from the 
OCD Command Shell in Workbench. For details on low-level commands, see the 
Wind River Workbench for On-Chip Debugging Command Reference.

4.2  Connecting to the Wind River Probe

Before you attempt to establish communications, please make sure that all 
hardware is properly connected to the host and the target, and that connections are 
tight (See 2. Setting Up Hardware for more information).

To establish a connection with the Wind River Probe, use the following steps.

1. Launch Wind River Workbench according to the method for your host.

Linux/Solaris Hosts

From your installation directory, issue the following command:

$ ./startWorkbench.sh 

Windows Hosts

Select Start > Programs > Wind River > Wind River Workbench 2.6.1 > Wind 
River Workbench 2.6.

Wind River Workbench launches. 

2. Specify a workspace.

For Windows hosts, Workbench displays a dialog where you can specify a 
location for your workspace. For Linux hosts, the workspace defaults to 
installDir/workspace. 

After you specify your workspace, Workbench opens and the Quick Target 
Launch dialog appears.
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The Quick Target Launch dialog allows you to create a launch configuration 
to initialize your target and download symbols and code. Once created, the 
launch configuration is persistent, so you can return to it at any time.

If this is the first time you have launched Workbench, the only available option 
is Create a new launch configuration. The next time you open Workbench, the 
Quick Target Launch dialog will give you the option of re-launching the same 
launch configuration or creating a new one.

3. Select Create a new launch configuration.

The New Connection Wizard appears. 
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4. Choose Wind River OCD Probe Connection from the list of options and click 
Next.

The Settings dialog appears.
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5. Click Select to choose from a list of available target processors. 

6. If a board file is necessary for your target board, check the Board File field and 
click Browse to specify the board file.

7. The field below the Board File field populates with a summary description of 
your board.

The USB Device Name field automatically populates with the serial number 
of your Wind River Probe unit.

NOTE:  Multi-core debugging is not supported for the Wind River Probe. 
Unless your target board has more than just the processor on the JTAG scan 
chain, you do not need to select a board file. (For example, the Wind River 
SBC405GP board has some FPGAs on the scan chain, so it does require a board 
file.)
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8. Click Next.

The Target Operating System Settings dialog appears.

9. In the Booted Target OS on selected CPU field, select the operating system 
that is running on your target processor. The default is None.

10. Next to the Kernel Image field, click Browse to navigate to the kernel image 
you wish to specify. If you selected None in the previous step, you do not need 
to specify a kernel image.

NOTE:  Because Wind River Probe uses a USB connection, several Wind River 
Probe units may be connected to your host computer at the same time. Make sure 
the USB Device Name field contains the serial number from the Wind River Probe 
unit you wish to use.
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11. If you are using a Linux plug-in, specify the pass-through options in the Target 
OS Pass-Through Options field. If you are not using a Linux plug-in, skip this 
step.

Options are passed as pairs in the format name=’value’. Separate options with 
a comma. The following options are available:

■ notasklist=1 : Never fetch process list.

■ noautomodules=1 : Do not plant internal breakpoints to do automatic 
kernel module load/unload detection. When this option is specified, you 
must manually refresh to see an updated module list.

■ noloadcheck=1 : Do not issue gophers until the hardware breakpoint is 
used to detect kernel load triggers. This option is for “sensitive” boards 
that don’t accept access until the kernel loads and sets up memory 
mapping.

■ loaddetectloc=symbol or address: Set the hardware breakpoint used to 
detect kernel load at symbol (for example, loaddetectloc=start_kernel) or 
address (for example, loaddetectloc=0x1000). If you do not specify a 
symbol or address, Workbench uses a default. For most architectures the 
default is start_kernel; for PowerPC targets, the default is 0x0.

12. Click Next.

The Memory Options dialog appears.
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Use the Memory Options dialog to specify how memory on the target is 
partitioned, and what the attributes of the particular memory regions are.

To specify an area of memory, click Add.

The Set Memory Map dialog appears.

NOTE:  The Memory Options dialog is only necessary for Linux or other 
non-VxWorks target operating systems.
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Use the Set Memory Map dialog to specify which memory areas are read-only, 
read-write, or write-only, and to specify the access width Workbench should 
use to read the data from those regions.

13. Click Next.

The Object Path Mappings dialog appears. 
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Use the Object Path Mappings dialog to specify how files in the target file 
system are visible in the host file system.

14. To add a host or target path, click Add... and type the path in the dialog that 
appears.

15. Click Next.

The Target State Refresh dialog appears.
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Use the Target State Refresh dialog to configure the target state query and 
target state refresh settings on your target processor.

16. Click Next.

The Default Breakpoint Options dialog appears.
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Use this dialog to set default breakpoint options for newly created 
breakpoints.

17. Click Next.

The Connection Summary dialog appears. Inspect the displayed values to 
make sure they are correct.
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18. If you want to connect to your target now, select Immediately connect to 
target if possible.

19. Click Finish. 

When you click Finish, you will see your target name appear in the Target 
Manager view. 

If your connection attempt is successful, a >BKM> prompt appears in the OCD 
Command Shell.

NOTE:  If you clear the Immediately connect to target if possible box, 
Workbench will not connect to your target. You can connect at any time by 
right-clicking on the target name in the Target Manager view and selecting 
Connect.



Wind River Probe for Wind River Workbench
Hardware Reference , 2.6.1  

32

If an >ERR> prompt appears in the OCD Command Shell, or if an error message 
similar to the one shown in Figure 4-1 appears when you try to connect, it indicates 
that problems have occurred during your communication attempt.

If you have problems establishing communications with your target, it is either 
because there is an error between Wind River Probe and the host or Wind River 
Probe and the target. See 5. Troubleshooting for more information. 

Workbench allows you to run and debug code either in combination with the 
Workbench project management facility, or without using a project. If you want to 
use a Workbench project to run and debug code, continue to 4.3 Setting up a Project, 
p.32. If you want to run and debug code without using a Workbench project, skip 
to 4.4 Downloading Code, p.35.

4.3  Setting up a Project

Several example projects are included in Wind River Workbench for 
demonstration purposes. To open a new demonstration project, use the following 
steps:

1. Select File > New > Example.

The New Example wizard appears.

Figure 4-1 Connection Error Message
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2. Select Standalone Sample Project and click Next.

The Sample Project template appears.
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3. Select C Demonstration Program and click Finish.

The project name c_demo_sa appears in the Project Navigator view.

4. Click on the “+” next to the project name to expand it.

A list of available build specs appear.
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4.4  Downloading Code

The Reset and Download view initializes your target and downloads an 
executable file. To perform a reset and download, use the following steps.

1. Highlight your target name in the Target Manager view.

2. Click the OCD Reset and Download button.

You can also right-click on your selected target name and choose Reset and 
Download... from the context menu.

The Reset and Download view opens displaying the Main tab.
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4.4.1  Projects to Build Tab

1. Select the Projects to Build tab.
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If you want Workbench to build your project before launching the reset and 
download operation, specify your project here. In the Projects to Build tab, 
select Add Project. From the list of available projects that appears, select the 
project you want to build and click OK.

4.4.2  Reset Tab

1. Select the Reset tab.

2. If you want to configure the target register values with a register file, select 
Play Register File and browse for the file you want to use.

This example shows a Wind River PPMC750FX target; the Wind River register 
file for this target is ppmc750fx.reg, located in 
installDir/workbench-2.x/dfw/build/host/registers, in the directory 
PowerPC/7xx/WindRiver_PPMC.

NOTE:  To enable this operation, make sure your launching preferences are 
correctly set. In the Workbench toolbar, select 
Window > Preferences > Run/Debug > Launching. In the General settings for 
launching field, make sure the Build (if required) before launching checkbox is 
selected. This checkbox is selected by default.
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If you do not want to reconfigure your target registers, leave this box 
unchecked.

3. Choose the type of reset initialization you want to perform.

You can use the IN or INN initialization commands. For a full discussion of 
these two commands, see 4.5 Initializing the Target, p.44.

You can also choose not to perform an initialization by clearing the Reset box.

4. Choose which core your reset and download will affect.

Specified Core is selected by default. Multi-core debugging is not supported 
for the Wind River Probe, so you do not need to set this option.

4.4.3  Download Tab

1. Select the Download tab.

2. Click Add Files.

! CAUTION:  If you are manually changing registers on your target, be aware that 
issuing an IN or INN initialization command will overwrite your changes.
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In the browser window that appears, navigate to the executable file you want 
to run. This example shows the PowerPC version of the executable cdemo.elf 
file from the sample C Demonstration Project.

The file you select appears in the Filename field. Repeat this process as many 
times as necessary. 

The file at the top of the list will download to the target first, followed by the 
others from the top down. You can edit the order of the list by clicking on any 
filename to highlight it and using the Up, Down, and Delete buttons.

3. Use the other fields to configure the download.

Download

The Download field is checked by default. If you clear it, the file will remain 
on the list but will not download data to the target. This is useful if, for 
example, you only want to download symbol information and not data.

Verify

The Verify field configures the extent to which the file you are downloading 
will be compared to a file that may already be on the target. There are three 
options: Full, Compare, and None.

When this field is set to Full, a write/read verify will occur for every 
download. Workbench will write to the target and then verify that the write to 
the target and the read from the target are identical. This is slower than a 
normal download, but it is a useful security option.

When the field is set to Compare, Workbench will verify that the image has 
been downloaded correctly (that is, that the image on the host is the same as 
the image on the target.) This is useful for programming flash. 

When the field is set to None, Workbench will perform no verification.

The Verify field is set to None by default.

NOTE:  You should only set the Verify field to Compare if an image already 
exists on the target. If you set the field to Compare when there is no image on 
the target, Workbench will look for a file to compare and not find one, and the 
reset and download operation will fail.
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Load Symbol

The Load Symbol field, which is checked by default, determines whether the 
file’s symbol information is downloaded to the target.

Offset

In the Offset field, you can enter a value in hex to set a memory offset bias for 
your application file. If you do not enter a value, Workbench uses the default 
value 0x00000000.

4.4.4  Instruction Pointer Tab

1. Select the Instruction Pointer tab.

2. Set the starting point for your file.

By default, the instruction pointer is set to use the starting address from the 
download file. 

You can set the instruction pointer to start the file from the first occurrence of 
a particular symbol (for example, main) or you can just specify a starting 
address by entering the address value in hex in the Use Specified Start 
Address field.
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If you do not want to set a starting point, clear the Set Instruction Pointer 
After Download box.

4.4.5  Run Options Tab

1. Select the Run Options tab.

2. Determine how you want your file to run.

By default, the Reset and Download view is set not to run the file after 
downloading. If you want the file to run, you have several options to 
determine where it should break:

■ You can set it to break at the first occurrence of a symbol (for example, 
main) by selecting Run to Symbol and entering the symbol in that field.

■ You can set it to break at the end of your program by selecting Run to end 
of program.

■ You can set it to break at a given memory address by selecting the Run to 
Address box and entering the address in hex in that field.

■ You can set it to break at an _exit routine by selecting the Break at Exit box.
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If you need to perform a post-initialization, you can define it here. Select the 
Play post download script box and click Browse. In the browser window that 
appears, navigate to your initialization file.

4.4.6  Source Tab

1. Select the Source tab.

2. Use the Source tab to configure the source path of your file.

Workbench uses the input path of the local file system by default. Unless you 
need to use a different path, you do not need to do anything in the Source tab.

If you need to use a different path, click Add... and use the Add Source dialog 
to configure the appropriate search path for your project.

4.4.7  Common Tab

1. Select the Common tab.
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2. Specify whether your launch configuration is local or shared.

The configuration is local by default. To make it shared, click Shared file: and 
browse to the shared directory where you want the configuration to be located.

You have now fully defined your reset and download operation.

4.4.8  Executing the Reset and Download

1. Click Debug.

This resets the target and downloads the specified file.

Workbench will first initialize the target board, then download the file, then 
run the file. 

The OCD Console view opens to show the progress of the reset and download 
operation.
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You can now step through instructions and debug code using the Resume and 
Suspend buttons in the Debug view. For information on debugging, see the Wind 
River Workbench User’s Guide.

4.5  Initializing the Target

When you make changes to your target using Wind River Probe and Wind River 
Workbench, you may have to initialize the target for those changes to take effect. 
You must initialize the target when you first try to establish communications with 
it. Similarly, if the code you run on your target causes the connection to be lost, then 
you also need to initialize the target in order to restore that connection. 
Initialization is also required if you change register settings in Workbench and 
want the changes to be reflected in the target.

The target is initialized whenever you first establish a connection using 
Workbench. If you need to initialize the target when you are debugging, use either 
the IN or the INN command. 
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The IN and INN commands are low level target initialization commands, and they 
are the easiest way to initialize the target when you work in the OCD Command 
Shell. 

The IN or INN command can be executed at a >BKM> or >ERR> prompt. If a >RUN> 
prompt is visible, stop the target by typing CTRL+C, CTRL+X, or by typing HALT. 
The target stops running and a >BKM> prompt appears. 

The IN and INN commands differ in that the IN command copies the register 
information that is stored on the host PC down to the target after it is placed in 
debug mode, whereas the INN command places the target in debug mode without 
overwriting the target registers, leaving them in their default reset state. More 
information about register settings is available in the Wind River Workbench for 
On-Chip Debugging User Tutorials. The following sections describe the IN and INN 
command in greater detail. 

INN Command

The INN command is a low level command that is used to place the target 
processor into debug mode. In order to get a processor into debug mode, the reset 
line of the processor is asserted and then released. As a consequence of entering 
debug mode, the processor and its peripherals on the target board are forced into 
their reset state and all of the internal registers are forced to their manufacturer’s 
reset value. 

IN Command

The IN command does two different things. First, as with the INN command, it 
places the target board into debug mode. Second, it copies all of the register 
information that is stored on the host PC down to your target. 

Wind River Probe writes register values to the target for all of the register groups 
that are enabled at the time of initialization. Even if code is located on the target to 
properly configure the registers, Wind River Probe still overwrites the values 
when it first establishes communications (is initialized). For that reason, it is 
important to make sure that the register settings that are stored on your PC match 
any register configuration code on the target. Use the SCT DIFF command to 
display the differences between the registers stored on your host PC and the 
registers on your target. More information about this command is available in the 
Wind River Workbench for On-Chip Debugging Command Reference, and more 
information about register configuration is available in the Wind River Workbench 
for On-Chip Debugging User Tutorials. 

If you do not want Wind River Probe to configure the registers during 
initialization, use the INN command instead of the IN command. 
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After initialization is completed, output displays in the OCD Command Shell:

>BKM>in
**************************************************************************
Wind River Probe Initialization Sequence.
Copyright (c) Wind River systems, Inc. 1999-2005. All Rights Reserved.
**************************************************************************

Support Expires.......4/20/06
Target Processor......PPC750FX:U1

Wind River Probe Group ID#= 0
Wind River Probe Serial#= U1234567 Firmware= pr3.0a
Type CF For a Menu of Configuration Options
Initializing Background Debug Mode..................Successful
>BKM>

The information includes the version number of the hardware, the target 
processor, and the operation mode.

4.6  Working with Wind River Probe

When you are in debug mode and have a >BKM> prompt visible in the OCD 
Command Shell, you can verify that Wind River Probe and your target work 
together correctly, and you can begin to work with your system. 

This section provides a brief description of some of the tasks that you can perform 
with your Wind River Probe unit. Detailed instructions and descriptions for 
performing most tasks are described in the Wind River Workbench for On-Chip 
Debugging User Tutorials. In addition, a complete command reference of the 
low-level Wind River Probe commands is included in the Wind River Workbench for 
On-Chip Debugging Command Reference. You can enter any of those commands at 
the > BKM > prompt in the OCD Command Shell with the correct syntax as 
described in the Command Reference.

4.6.1  Configuration Options

To see the configuration options available for your target, open the Device Debug 
perspective in Workbench and click on Window in the toolbar. From the 
drop-down list that appears, choose Show View > CF Options View.

Figure 4-2 shows an example of the CF options that are available for a PPC750FX 
target.
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Choose an option and click on it in the Current Settings column. A drop-down list 
appears; scroll down the list to the parameter you want and click on it to reset the 
option. For example, to disable the Checkstop Interrupt, click on that option in the 
Current Settings column. The list of parameters (in this case YES and NO) 
appears; click on NO to disable the option.

After you change the CF options, click the Send All CF Options to Target button.

A full list of many of the available configuration options and descriptions is 
available in the Wind River Workbench for On-Chip Debugging Configuration Options 
Reference. Please refer to that document for more information about configuration 
options. 

Figure 4-2 CF Options

NOTE:  The CF options listed will not be the same for all targets. This is a PPC750FX 
example only.
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Editing CF Options with Low-level Commands

Alternatively, your target can be configured using the low-level CF command, 
which can be issued at either a >BKM> prompt or an >ERR> prompt. The 
configuration options for a target vary depending on the target you are using. Type 
CF at a prompt to see a list of the options that are available for your target. Please 
note that these options are subject to change with new revisions of the product.

To make a change to any of these values, type CF and the CF command option to 
be modified, followed by the specific parameter to configure (all on the same 
command line). 

For example, to change the location of the exception vector from Low to High, you 
would type: 

>BKM>CF VECTOR HIGH

If you type CF again and press ENTER, you would see that HIGH appears next to 
the Vector Table Location parameter in the list of configuration options. 

4.6.2  Boot Register Initialization

After communications are established with Wind River Probe and the target, 
program and configure the registers that are required for initialization, a necessary 
step prior to downloading code. In order to be able to access a peripheral device 
using the OCD link on your target, it is necessary for all applicable registers in the 
interface to be properly configured.

NOTE:  Most changes to CF options do not take effect until you issue a reset, either 
through the GUI or by entering the IN or INN command in the OCD Command 
Shell.

NOTE:  The CF command can be entered at either the >BKM> prompt or the >ERR> 
prompt. The command cannot be used at a >RUN> prompt. 

NOTE:  If your target has valid running boot initialization code, you may omit the 
register initialization process and rely on your own boot code to initialize your 
board. To reset your target, start your boot code, and stop the target, type INN, GO, 
and then HALT in the OCD Command Shell. To automate the command sequence 
prior to each load, refer to the Wind River Workbench User’s Guide.
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Detailed information about how to work with registers is included in the 
Wind River Workbench for On-Chip Debugging User Tutorials. Please refer to that 
document for more information about how to program and configure the registers 
required for initialization.

4.6.3  Setting Chip Selects 

The CS command provides information about a special set of registers that are 
used to control the chip selects on a target. Not all targets have programmable chip 
selects. Refer to your processor documentation for information about chip selects 
on your target. 

If your target does include programmable chip selects, the CS command enables 
you to view a table that lists the available chip selects with all of their options. Each 
of the entries in the table can be programmed as described below.

Type CS at the >BKM> prompt with no parameters to display the chip select table 
for your target, as shown inFigure 4-3.

To modify any of the chip selects, type the CS command followed by the name of 
the chip select you want to modify. The options and the current settings for that 
chip select display one line at a time, allowing you to make individual changes to 
the settings. The chip select table is stored on your host PC, and is automatically 
downloaded after every initialization sequence using the IN command. If you 
want to initialize the system without writing the chip select table, use the INN 
command, or disable the chip select group using the CF GRP command, as 
described in the Wind River Workbench for On-Chip Debugging User Tutorials.

Figure 4-3 Chip Select Table
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Any time you change the chip select table, issue an IN command to download your 
new table to the target so that your changes will take effect. 

4.7  Moving On

For information on using your Wind River Probe to download, run, and debug 
application files in Wind River Workbench, please see the Wind River Workbench for 
On-Chip Debugging User Tutorials and the Wind River Workbench User’s Guide.
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5.1  Introduction

This chapter covers troubleshooting for the Wind River Probe.

Problems with the Wind River Probe generally fall into two types: connection 
errors (problems between the Wind River Probe and the host computer) or 
communication errors (problems between the Wind River Probe and the target.) 
Both are covered in the sections that follow.

If no prompt is visible in the OCD Command Shell, or if an error message is 
visible, it is likely that the connection error is between Wind River Probe and the 
host computer. 

An >ERR> prompt in the OCD Command Shell indicates that a connection has 
occurred, so the problem is between the Wind River Probe and the target.
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5.2  Troubleshooting Connection Problems

On the face of the Wind River Probe there is an LED labelled power/activity. This 
LED should light up when you connect the Probe to your host computer. If the LED 
does not light up, first check to make sure both ends of the USB cable are tight. 
Then:

Windows Hosts:

1. Choose Start > Control Panel > System.

2. In the System Properties dialog, select the Hardware tab.

3. Select Device Manager.

4. In the Device Manager, expand the Universal Serial Bus Controllers node.

You should see an entry for Wind River Probe (PRxxxxxx).

If the entry is not there, you must reinstall the driver from your installation DVD.

Linux Hosts:

An entry for WRProbeSvc should appear in the /proc directory. 

Many Linux distributions also have a GUI tool for this purpose. For instance, in 
Red Hat Linux, select System Tools > Hardware Browser > System Devices.

You should see an entry for Wind River Systems/Wind River Probe.

If the entry is not there, you must reinstall the driver from your installation DVD.

5.2.1  Wind River Probe Diagnostic Test -- Windows

If the entry does appear, but you cannot connect, you can get some indication of 
where the problem lies by running the Wind River Probe diagnostic test.

On Windows hosts, the diagnostic test WRPuTest.exe is located in the directory 
installDir/workbench-2.x/dfw/build/host/x86-win32/bin/visionProducts, in the 
folder Hardware.

The Wind River Probe diagnostic is mainly intended to give you information to 
relay to Wind River technical support.
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Connecting

If you have more than one Wind River Probe connected to your host computer, 
select the one you want to test in the Connection field.

To test the connection, click Connect.

This queries the Wind River Service on the host (installed with the Wind River 
Workbench DVD) and on the Wind River Probe (through the USB driver.) It also 
queries the integrity of the packet processing engine (PPE), the 8051 on-board 
CPU, and the FPGA. If any of these queries fail, the connection fails.

Updating Firmware

The firmware for the Wind River Probe resides on an EEPROM that maintains the 
firmware for the on-board CPU and FPGA. 

Figure 5-1 Wind River Probe Diagnostic
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One reason you may not be able to connect is that the firmware file may be out of 
date or corrupted. To update the Wind River Probe firmware:

1. In the Connection field, click Connect.

2. In the EEPROM Update field, click Browse.

3. In the browser window that appears, navigate to the firmware file 
wrProbe8051Firmware.iic. On Windows hosts, this is located in 
installDir/workbench-2.x/dfw/build/host/x86-win32/bin, in the directory 
visionProducts/USBDriverFiles.

4. Click Program.

Figure 5-2 Wind River Probe Schematic
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The diagnostic automatically disconnects from the Probe when the update 
completes. When the update is completed, you must physically disconnect the 
Probe from your host computer and then reconnect it.

Diagnostic Test

To run the Wind River Probe diagnostic test:

1. In the Connection field, click Connect.

2. Click Start Diagnostic.

The results are displayed in the Diagnostics Results/Status field, as shown in 
Figure 5-4.

Figure 5-3 Firmware Update
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The diagnostic returns the version numbers (driven by the firmware) and then 
runs three tests.

First it tests the speed of the USB connection, and returns the value--LOW SPEED 
(USB 1.0), FULL SPEED (USB 1.1) or HIGH SPEED (USB 2.0).

Next it toggles the Wind River Probe LEDs. The LEDs should blink in this order:

run/debug -- off > yellow > green > off.

power/activity -- steady green > off > blinking green > steady green.

Finally, the diagnostic performs an on-board loopback test. If this test fails, it 
indicates that the USB Driver or the packet processing engine (PPE) have failed.

5.2.2  Wind River Probe Diagnostic Test -- Linux

On Linux hosts, the Wind River Probe diagnostic test is a command-line utility, 
invoked by the command wrpdiag.

The wrpdiag command takes the following options:

Figure 5-4 Diagnostic Test



5  Troubleshooting
5.2  Troubleshooting Connection Problems

57

5

Example 1

The following command lists all Wind River Probes connected to your host:

$ ./wrpdiag -l 

Example 2

The following command runs a diagnostic on all Wind River Probes connected to 
your host and prints version information, and diagnostic results, for each 
Wind River Probe:

$ ./wrpdiag -lavd 

Updating Firmware

The firmware for the Wind River Probe resides on an EEPROM that maintains the 
firmware for the on-board CPU and FPGA (see Figure 5-2.). One reason you may 
not be able to connect is that the firmware file may be out of date or corrupted. 

On Linux hosts, this file is WRProbe8051Firmware.iic, located in 
installDir/workbench-2.x/dfw/build/host/x86-linux2/bin, in the directory 
visionProducts/USBLinuxDriverFiles.

Example 1

The following command updates the firmware for Wind River Probe PRO12345:

$ ./wrpdiag -s PRO12345 -u WRProbe8051Firmware.iic 

Table 5-1 wrpdiag Options

Option Action

-s serial_number  Test a Wind River Probe with the specified serial number.

-a Apply command to all Wind River Probes connected to your 
host.

-l List all Wind River Probes connected to your host.

-u filename Update specified Wind River Probe(s) with the specified 
firmware file.

-v Display version information for specified Wind River Probe(s).

-d Run diagnostics on specified Wind River Probe(s).
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Example 2

The following command updates the firmware for all Wind River Probes attached 
to your host:

$ ./wrpdiag -a -u WRProbe8051Firmware.iic 

5.3  Troubleshooting Communication Problems

Communication errors between Wind River Probe and the target are typically 
indicated by an > ERR > prompt in the OCD Command Shell. The following 
sections describe three solutions that you can try to correct this error.

Register Files

If the target board you are using was shipped with the registers uninitialized, you 
may have to download a register file (.reg) to the target (or specify one in your 
board description file) before you are able to get the processor into debug mode 
and see a >BKM> prompt in the OCD Command Shell. The Wind River Workbench 
On-Chip Debugging Guide provides step-by-step instructions about how to 
download a register file to your target. Refer to the documentation that came with 
your board to verify how the registers on your target board were shipped. Often, 
your board includes a register file for the board that you need to download. 

If an INN command passes, but an IN command fails, this indicates a register file 
issue. See 4.5 Initializing the Target, p.44.

Set Verbose Command

The SET VERBOSE ON command puts Wind River Probe into verbose mode, 
which can be useful when you attempt to diagnose connection problems. Using the 
IN command at an >ERR> prompt only shows that the attempt to connect failed. 
Using verbose mode provides more information about where the communication 
attempt failed. 

The following steps describe how to use verbose mode:

1. Type SET VERBOSE ON at the >ERR> prompt in the OCD Command Shell. 

2. Press ENTER.

This returns you to an >ERR> prompt.
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3. Type IN at the >ERR> prompt and press ENTER.

This time, the output in the OCD Command Shell lists all of the diagnostic tests 
that it performs while trying to place the target in debug mode, and states whether 
the test passes or fails. The following output shows an example of a JTAG target 
being initialized with verbose mode enabled:

>ERR>set verbose on
>ERR>in
***************************************************************************
Wind River Probe Initialization Sequence.
Copyright (C) Wind River Systems, Inc. 1999-2004.  All rights reserved.
***************************************************************************

Support Expires.......4/20/06
Target Processor......PPC750FX:U1

Wind River Probe Group ID#= 0
Wind River Probe Serial#= U1234567 Firmware= pr3.0a
Type CF For a Menu of Configuration Options

Testing Communications to Hardware Interface....Passed
Driving HRESET to be High.......................Passed
Driving HRESET to be Low........................Passed
Waiting HRESET Low Acknowledge..................Failed
>ERR>

Use verbose mode to help you determine why the target cannot be placed in debug 
mode. The Wind River Workbench for On-Chip Debugging Command Reference 
describes each of the diagnostic tests that are performed, and provides items that 
you can check to try to correct the problem. 

Hardware

An >ERR> prompt in the OCD Command Shell can also signify a problem with 
the hardware connections between Wind River Probe and the target. Check the 
following items to determine if the connection problem is hardware related:

■ Verify that you correctly made all connections as described in 2. Setting Up 
Hardware. 

■ Verify that you correctly applied power to both the host computer and the 
target. 
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5.4  Troubleshooting License Key Problems

If the error message shown in Figure 5-5 appears when you try to connect, your 
emulator’s license key is incorrect or expired. 

To upgrade your license key, use the following steps:

1. Right-click in the Target Manager and select OCD Utilities > Capture Current 
Key to File.

A browser window appears.

2. In the browser’s Look In field, select Desktop.

3. In the browser’s File Name field, enter your name and append .txt.

For example, if your name were John Smith, you would name the file 
JohnSmith.txt.

4. Click Open. 

Workbench automatically creates the text file and logs your current license key 
to it.

5. Send an email to licadmin@windriver.com and attach the text file you created 
in the preceding steps.

This file contains the license key that Wind River needs in order to upgrade 
your Wind River Probe.

When you request a new license key, your email must include the sales order 
number associated with the upgrade. Within 24 hours you will receive a message 
with a text file attachment that contains your upgraded license key.

To install your new license key, use the following steps:

1. Open the email message you received from Wind River and save the attached 
file to your desktop.

Figure 5-5 License Key Error Message
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2. Connect your Wind River Probe to your host PC and open Wind River 
Workbench. 

3. Right-click in the Target Manager and select OCD Utilities > Install License 
Key From File.

A browser window appears. 

4. Navigate to the file you saved on your desktop in Step 1 and Click Open.

This burns your new license key.

5.5  Troubleshooting Performance Problems

If you lose connectivity to the Wind River Probe due to noise on the lines, use the 
HIC command in the OCD Command Shell to change the properties of the 
electrical interface.

Entering HIC with no arguments returns a list of all user-changeable electrical 
properties:

>BKM>hic
Clock Frequency in KHz CLKK[25...100000] = 16000
Clock Phase CLKPHASE[-180..+900] = 0
Clock External synchronization RTCK[ENABLE,DISABLE] = DISABLE
CLK Drive Strength CLKSTRENGTH[1..4] = 2
TMS Drive Strength TMSSTRENGTH[1..2] = 1
TDI Drive Strength TDISTRENGTH[1..2] = 1
Target Interface voltage Override VOLTAGE[3.3V,2.5V,1.8V,VIO] = VIO
Target Interface termination voltage TERMVOLTAGE[2.5V-3.3V,1.8V-2.5V] = 
2.5V-3.3V
CLK Termination CLKTERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = ACTIVE_HI
TMS Termination TMSTERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = ACTIVE_HI
TDI Termination TDITERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = ACTIVE_HI
TDO Termination TDOTERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = ACTIVE_HI
GPIO0 Termination GPIO0TERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = ACTIVE_HI
GPIO1 Termination GPIO1TERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = ACTIVE_HI
GPIO2 Termination GPIO2TERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = PASSIVE
GPIO3 Termination GPIO3TERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = PASSIVE
GPIO4 Termination GPIO4TERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = PASSIVE
GPIO5 Termination GPIO5TERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = PASSIVE
GPIO6 Termination GPIO6TERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = PASSIVE
GPIO7 Termination GPIO7TERM[ACTIVE_HI,ACTIVE_LO,PASSIVE] = PASSIVE
GPIO Output Enable Value (GPIO7..GPIO0) GPIOXOE[VALUE] = 0x01
GPIO Output Value (GPIO7..GPIO0) GPIOXOV[VALUE] = 0x03
GPIO Intput Value (GPIO7..GPIO0) = 0x27
>BKM>



Wind River Probe for Wind River Workbench
Hardware Reference , 2.6.1  

62

Example

In this example, set the strength of the TCK signal to 4.

>BKM> HIC TCKSTRENGTH 4

When all parameters are configured, you can save the configuration in XML 
format using the command HIC BRDDUMP:

>BKM>hic brddump
<CLKK>16000</CLKK>
<CLKPHASE>0</CLKPHASE>
<RTCK>DISABLE</RTCK>
<CLKSTRENGTH>2</CLKSTRENGTH>
<TMSSTRENGTH>1</TMSSTRENGTH>
<TDISTRENGTH>1</TDISTRENGTH>
<VOLTAGE>VIO</VOLTAGE>
<TERMVOLTAGE>2.5V-3.3V</TERMVOLTAGE>
<CLKTERM>ACTIVE_HI</CLKTERM>
<TMSTERM>ACTIVE_HI</TMSTERM>
<TDITERM>ACTIVE_HI</TDITERM>
<TDOTERM>ACTIVE_HI</TDOTERM>
<GPIO0TERM>ACTIVE_HI</GPIO0TERM>
<GPIO1TERM>ACTIVE_HI</GPIO1TERM>
<GPIO2TERM>PASSIVE</GPIO2TERM>
<GPIO3TERM>PASSIVE</GPIO3TERM>
<GPIO4TERM>PASSIVE</GPIO4TERM>
<GPIO5TERM>PASSIVE</GPIO5TERM>
<GPIO6TERM>PASSIVE</GPIO6TERM>
<GPIO7TERM>PASSIVE</GPIO7TERM>
<GPIOXOE>0x01</GPIOXOE>
<GPIOXOV>0x03</GPIOXOV>
<GPIOXIV>0x27</GPIOXIV>

>BKM>

Copy this output to a board file that you can use for every connection.
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